Introduction to VA Analysis using openVA
the R Shiny App in Windows 10
Jason Thomas & Sam Clark
September 28, 2017

1

Introduction

There are several methods for analyzing verbal autopsy (VA) data with the goal of assigning
a cause of death. openVA for the R free software environment consolidates many of these
tools into a single package. This document serves to introduce the openVA package through
the installation and use of a user-friendly R Shiny app. After an initial setup, the user
can analyze VA data with different algorithms and access results without having to learn
the R programming language. Part of the focus in the following sections relates to data
collected and managed using the Open Data Kit, which is prepared for analysis using another
R package, namely, CrossVA. The information presented here provides all the necessary steps
for an introduction to openVA, but more information on the software can be found at the
following sites:
• R software environment – https://cran.r-project.org/
• openVA– https://cran.r-project.org/package=openVA
• R Shiny – https://shiny.rstudio.com/
• Open Data Kit (ODK) – https://opendatakit.org/
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2.1

Installing and Starting R Shiny App for Windows 10
Quick Version

Download the R Shiny zip file at
https://github.com/jarathomas/openVA-Pipeline/tree/master/RShinyApp/shiny-openVA.zip
and unzip it – the contents should include three files: (1) shiny-openVA.R (R Shiny script file); (2)
CrossVA 0.9.3.zip (an R package); and (3) va data from odk.csv (an example data file from ODK).
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1. Install Java (https://java.com/en/download/)
2. Download the R executable (with same architecture as Java, e.g., 64-bit) from
https://cran.r-project.org/bin/windows/base/ and double-click the file to install R
3. Start R and install the necessary packages by typing the following in the R Console window
at the prompt >
install.packages(c("openVA", "shiny", "shinyjs"), dependencies=TRUE)
A new window should appear asking the user to select a Secure CRAN mirror, and the
installation will begin after clicking the Ok button.
4. Install the CrossVA package (included in the R Shiny zip file) by clicking, in the R menu bar,
Packages > Install package(s) from local files . . . then select the CrossVA 0.9.3.zip file (you
may need to navigate to the folder where the R Shiny zip file was downloaded) and click the
open button at the bottom-right of the Select files window.
5. Open the shiny-openVA.R script (included in the R Shiny zip file) through the R menu bar
File > Open Script . . . then select the shiny-openVA.R script file and click the open button
at the bottom-right of the Open script window. This step should open a new R Editor
window.
6. Make sure the focus is on the R Editor window (by clicking on it) and run the shiny-openVA.R
script through the menu bar Edit > Run all which will execute the code (in the R Console)
and open your web browser with the R Shiny app.

2.2

More Details

The R software is available for download from the Comprehensive R Archive Network (CRAN)
https://cran.r-project.org/bin/windows/base/. Installation instructions are also available
from CRAN, but the process should be familiar: download the executable file (ending in .exe
and double-click the file. The R Shiny app uses several packages, one of which requires Java
(version 6 or above) to be installed on your computer (https://java.com/en/download/). It is
not unusual to experience difficulties while trying to configure R to work with Java. For more details
about the configuration procedure, see the InSilicoVA manual (https://github.com/richardli/
InSilicoVA/blob/master/Documents/Insilico-manual.pdf).
After Java and R have been installed, the next step is to install R packages that contain the
tools needed for the Shiny app to run. Start the R Gui by double-clicking the icon
and install
the necessary packages with the command
install.packages(c("openVA", "shiny", "shinyjs"), dependencies=TRUE)
which should be typed in the R Console window at the prompt as follows:
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A new window should appear asking the user to select a Secure CRAN mirror (choose a CRAN
mirror near your location), and the installation will begin after clicking the Ok button.

You will see A LOT of text scrolling in the R Console which describes the installation of the
numerous packages the Shiny app needs. A modified version of the CrossVA package also needs to
be installed with the following three steps: (1) select the R menu bar options
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Packages > Install package(s) from local files . . .

(2) select the CrossVA 0.9.3.zip file (you may need to navigate to the folder where the R Shiny zip
file was downloaded); and (3) click the open button at the bottom-right of the Select files window.
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Next open the shiny-openVA.R script (included in the R Shiny zip file) through the R menu bar
File > Open Script . . .
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then select the shiny-openVA.R script file and click the open button at the bottom-right of the
Open script window.
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This step should open a new R Editor window. Make sure the focus is on the R Editor window (by
clicking on it) and run the shiny-openVA.R script through the menu bar Edit > Run all which will
execute the code (in the R Console) and open a web browser with the R Shiny app. It may take
a few seconds for the app to appear in the web browser as the code is processed in the R Console
window.
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Finally, to stop the Shiny app, return to the R Gui and click on the red stop sign button in the
tool bar.
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Using the R Shiny app

Once the R Shiny app is running in a web browser there are is a panel on the left side of the web
page where the data and analysis options are entered.
1. Upload your own data here – The first input is a data file in Comma Separated Values
(CSV) format. After clicking the Browse button a window will appear allowing you to select
your data file. Once the data have been loaded the app produces the message “Upload
complete”. There is a sample data file, va data from odk.csv, that is included in the R Shiny
zip file and used in the examples below. Note that once a data file has been uploaded a new
button will appear Analyze my data!.
2. Choose your preferences – The data are assumed to be in a particular format with fields
identifying the age and gender of the deceased. There are several options for selecting groupspecific results. Note that the time it takes to process the data increases with the number of
groups selected.
(a) Include an analysis of all records? – This option is selected by default, but it is
not necessary
(b) Include sex-specific results? – simply click in the empty box to produce separate
results for males and females
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(c) Include age-specific results? – simply click in the empty box to produce separate
results for infants (less than 1 year old), children (aged 1-4 years old), and adults (ages
5 and above)
3. Select Algorithm
(a) InSilico – the number of iterations in the simulations can also be specified; the default
is 5,000, but if you are simply exploring/testing out the app you may want to choose
the lower end (and reduce the processing time); the part of the InSilico algorithm is
implemented in Java and thus a separate windows will appear with a Java Progress Bar
indicating the percentage of iterations that have been completed. (Technical note: if the
algorithm does not converge in the specified number of iterations, it will automatically
add additional iterations to the simulation.)
(b) InterVA4 – specify the level of HIV and malaria prevalence; which are the same
parameters required by the InterVA-4 software developed by by Peter Byass (http:
//www.interva.net/). Here is the description from the InterVA-4 User Guide (version
4.04, 2017-06-06): “These settings do not directly determine the cause of death, but
conceptually they are similar to a physician knowing that (s)he is working in a high or
low malaria or HIV population, irrespective of the details of a specific case currently
under consideration.” (p.6)
4. Data Checks – Are the data from an ODKBriefcase export?; this option is checked by
default and refers to the CSV file generated by the ODKBriefcase command line interface
with arguments to the options “–export filename” and “–export directory” (for more details,
see https://opendatakit.org/use/briefcase/); for data from a different source, see the
InSilicoVA documentation for the required data format (https://cran.r-project.org/
package=InSilicoVA)
5. Analyze my data! – Processing the data can take a while with a large amount of data.
With 500 cases it may take anywhere from 5 to 30 minutes depending on the algorithm
(InSilico typically takes longer, and the waiting time will obviously increase with the number
of iterations for the simulation). Once pressed, a progress bar will appear.
This side panel also includes several additional buttons that are inactive when no data have
been analyzed. These buttons allow you to download results in the form of CSV files and PDF
files (for plots), as well as additional text files that document error and warning messages. After
providing the necessary data and pressing the Analyze my data! the data will be processed and
these buttons will become active (i.e., you may click on them) as the results are obtained.

3.1

InSilicoVA Example

In our first example, we analyze the sample data set va data from odk.csv (15 records/deaths)
generated from an ODKBriefcase export and included in the R Shiny zip file. Results are requested
for all records and separately by gender and age groups. InSilico is the algorithm being used with
the number of iterations set to 600. This took about one minute on a laptop with a 2.7GHz Intel
Core i-7 processor.
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The results are displayed on the right side of the web browser and begin with a table that lists
the number of deaths by age and sex that are included in the data. Summaries for the top 10 causes
of death and plots of the cause-specific mortality fraction for the top 20 causes are also included for
each group selected – results are presented in the following order: total population, males, females,
infants, children (results are empty since there are no child deaths in the data), and adults.
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Finally, the results are available for download by clicking on the buttons appearing in the panel
on the left side of the browser, with the options described in the following list:
• Download Causes for All Records as .csv – this file includes the record ID (which is
simply the row number in the original data file) and the three most likely causes of death
and the associated probabilities; note that some records (5, 9, and 15) are excluded due to
data errors (i.e., missing necessary data/indicators; or inconsistencies among indicators that
cannot be reconciled).
• Download Summary for All Records as .csv – this file contains the information appearing in the web browser under the title “Summary of Results using All Records”
• Download Plot for All Records as .pdf – this file contains the CSMF displayed on the
right side of the web browser
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• The three options listed above are available for each group included in the analysis
• Download warnings as .txt – located at the very bottom of the panel on the left side of
the web browser, this text file includes the warning and error messages generated by InSilico
and the issues encountered and, in some cases, the steps taken to reconcile the inconsistencies
in the data

3.2

InterVA Example

For our second example, we analyze the same data but use the InterVA4 algorithm with the HIV
and malaria options set to “very low”.

The results are slightly different because InSilico includes uncertainty (similar to confidence
intervals) around the point estimates, whereas InterVA4 does not. However, the number of deaths
tabulated by age and sex as well as the top causes of death (top 10 for the summary and top 20
in the CSMF plot) are still included. The corresponding results are also available for download by
clicking on the buttons in the panel on the left side of the browser.
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